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Edition Notice
© 2015-2023 Haivision. All rights reserved.

This edition and the products it describes contain proprietary and confidential information. No part of this 
content may be copied, photocopied, reproduced, translated or reduced to any electronic or machine-
readable format without prior written permission of Haivision. If this content is distributed with software 
that includes an end-user agreement, this content and the software described in it, are furnished under 
license and may be used or copied only in accordance with the terms of that license. Except as permitted 
by any such license, no part of this content may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the 
prior written permission of Haivision Systems, Inc. Please note that the content is protected under 
copyright law even if it is not distributed with software that includes an end-user license agreement.

About Haivision
Founded in 2004, Haivision is now a market leader in enterprise video and video streaming technologies. 
We help the world’s top organizations communicate, collaborate and educate. Recognized as one of the 
most influential companies in video by Streaming Media and one of the fastest growing companies by 
Deloitte’s Technology Fast 500, organizations big and small rely on Haivision solutions to deliver video. 
Headquartered in Montreal, Canada, and Chicago, USA, we support our global customers with regional 
offices located throughout the United States, Europe, Asia and South America.

Trademarks
The Haivision logo, Haivision, and certain other marks are trademarks of Haivision. CoolSign is a 
registered trademark licensed to Haivision Systems, Inc. All other brand or product names identified in 
this document are trademarks or registered trademarks of their respective companies or organizations. 

Disclaimer
The information contained herein is subject to change without notice. Haivision assumes no responsibility 
for any damages arising from the use of this content, including but not limited to, lost revenue, lost data, 
claims by third parties, or other damages.

If you have comments or suggestions, please contact infodev@haivision.com.

While every effort has been made to provide accurate and timely information regarding this product and 
its use, Haivision Systems Inc. shall not be liable for errors or omissions contained herein or for incidental 
or consequential damages in connection with the furnishing, performance, or use of this material. 

mailto:infodev@haivision.com
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About This Document
Conventions
The following conventions are used to help clarify the content.

Typographic Conventions and Elements

Italics Used for the introduction of new terminology, for words being used in a 
different context, and for placeholder or variable text.

bold Used for strong emphasis and items that you click, such as buttons.

Monospaced Used for code examples, command names, options, responses, error 
messages, and to indicate text that you enter.

> In addition to a math symbol, it is used to indicate a submenu. For instance, 
File > New where you would select the New option from the File menu.

...  Indicates that text is being omitted for brevity.

Action Alerts
The following alerts are used to advise and counsel that special actions should be taken.

Tip

Indicates highlights, suggestions, or helpful hints.



Note

Indicates a note containing special instructions or information that may apply only in special cases.



Important

Indicates an emphasized note. It provides information that you should be particularly aware of in 
order to complete a task and that should not be disregarded. This alert is typically used to prevent 
loss of data.


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Obtaining Documentation
This document was generated from the Haivision InfoCenter. To ensure you are reading the most up-to-
date version of this content, access the documentation online at https://doc.haivision.com. You may 
generate a PDF at any time of the current content. See the footer of the page for the date it was 
generated.

Getting Service Support
For more information regarding service programs, training courses, or for assistance with your support 
requirements, contact Haivision Technical Support using our Support Portal at: https://
support.haivision.com.

Caution

Indicates a potentially hazardous situation which, if not avoided, may result in damage to data or 
equipment. It may also be used to alert against unsafe practices.



Warning

Indicates a potentially hazardous situation that may result in physical harm to the user.



https://doc.haivision.com
https://support.haivision.com
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The CoolSign® Content Creator is a full-featured application for creating content for a Digital Media 
Network. It is specially designed to aid in the design and creation of content that uses dynamic data, but 
can be used as a general-purpose content animation tool as well.
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Getting Started with Content Creator

Topics Discussed

CoolSign Content Creator Requirements
Working with Projects

Project Settings
General Project Settings
Playback Project Settings
Dynamic Data Project Settings
Advanced Project Settings

Understanding the Content Creator Workspace
Customizing Your Workspace

Using the Media Window
Using the Media Window Selection Tool
Using the Media Window Zoom Control
Setting Display Options in the Media Window

CoolSign Content Creator Requirements

Supported Media Formats

Audio Image Video

MP3 bmp gif 
jpeg png psd

WMV 
Flash 
MPEG-1 
MPEG-4

AVI 
M2V 
MOV 
MP4 (H.264 only) 
H.264

Working with Projects
When you launch CoolSign Content Creator, the Welcome window automatically appears:

•
•

Important

The Content Creator tool is not compatible with remote desktop software.
The content created with the Content Creator tool is Javascript, not HTML.

For example, while the CoolSign Media player does support an Italics property on each 
text asset, there is no support for making part of a text asset italic using an expression. As 
a workaround, you could separate the data that needs to be italicized from the data that 
should not be italicized, and bind those to two or more separate assets. Then enable the 
Italics property on the one text asset where it is desired.


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Within Content Creator, all of your work takes place within the context of a project. In this section, you'll 
define settings for your project.

To open a new project, click Create new project.
To open an existing project, click Open existing project and select the project folder.

Then choose the menu item Project > Project Settings.

Project Settings
The Project Settings allow you to specify how the content is displayed, transitioned, triggered — even 
how missing data is handled. 

The Project Type can be either:

STANDARD — (default) used for developing most individual pieces of content; anything from 
simple pictures and videos to more complex content that displays dynamic data.
TEMPLATE — used when creating a model that will be used to create new instances of content with 
similar layouts but that might differ in the actual text and/or graphic elements from the model.

General Project Settings

In the General tab, you define the project type, name, duration, display type, orientation, and resolution. 1 

Project Settings: General Tab

Important

You can only specify the Project Type when you create a new project. Unlike other project 
settings, the Project Type can not be revised after the project has been created.


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Fields Purpose

Project Type Select the appropriate listing for the 
type of content you are creating:

Standard
Template

Name The name of your content as it appears 
in CoolSign Network Manager (CNM).

Duration Length that your content plays. The 
duration is limited by the length of your 
imported asset.

Display Type If you select a preset display type, the 
orientation and resolution fields are 
automatically filled in for you. Your 
content can still be displayed on other 
display devices but looks best on this 
display type.

Orientation Landscape or portrait, depending on 
how you'll be orienting the target 
display device.

Resolution The horizontal and vertical resolution of 
your content in pixels.

1. Project Type can only be specified when a new project is being created and not by opening the 
Project Settings for an existing project.     

Playback Project Settings

In the Playback tab, you define the effect that you'll use to transition into this content, along with settings 
that affect how content is resized during playback.
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Dynamic Data Project Settings

In the Dynamic Data tab, you define what to do if the data table is empty.

Data tables are mini-databases with a structure that is flexible enough to enable you store anything from 
a single piece of information to a complex table with dozens of fields and hundreds of records of data. 
Refer to the CoolSign Network Manager User's Guide for more details.

Continue playback with no data — Play the content anyway, even if no data is present.
Abort playback and silently log an error — Don't play the content, but do not log a visible error.
Abort playback and set region status to Content Error — Don't play the content and issue a region 
status error.

When you're done, click the Advanced tab.

Advanced Project Settings

In the Advanced tab, you can define additional settings that affect your content.
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Content scheduled as triggered — Check this box if you are creating dynamic content that you 
intend to schedule as triggered with CNM. This setting modifies the content scripts to work 
correctly when triggered.
Content used as Overlay Content — Check this box if you are creating content that you intend to 
use in the Overlay Content channel of a player. Overlay content is played on top of the currently 
tuned channel's content. (Deprecated; this checkbox is provided to support legacy content. See the 
discussion of Layering Regions in the Configuring Players and Devices section of the CoolSign 
Network Manager User's Guide.)
Return to content — If you are creating content that you intend to be interactive, you can enter the 
name of the content that should be played immediately after this content is played.

When you're done, click OK to save your project settings and open the Content Creator workspace.

Understanding the Content Creator Workspace
The Content Creator workspace enables you to define, layout, and preview your CoolSign content as you 
work.

The workspace contains the following components:

Menu bar — Contains menus for performing tasks. Many of the menu functions can also be 
accomplished from the keyboard or by using other Graphical User Interface (GUI) controls. For 
example, you can start content playback by choosing PLAYBACK > PLAY, entering Ctrl-P, or 
clicking the Play arrow button in the Timeline window.

 
Media window — Displays the current content as well as a toolbar for manipulating and creating 
assets. You can think of the media window as the stage on which all of your actions take place: 
drawing shapes, adding text, resizing content, positioning imported assets, laying out data fields, 
and viewing content playback. See Using the Media Window.
Timeline window — Contains buttons for previewing the playback of your content and lists all of 
the layers in your project. See Using the Timeline Window.

https://doc.haivision.com/display/CS5v2/Layering+Regions
https://doc.haivision.com/display/CS5v2/Configuring+Players+and+Devices
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Properties window — Displays properties for the asset that is currently selected in the timeline 
window or media window.
Data Tables window — Enables you to create and manage the dynamic data table that is used to 
provide data to your content. See Working with DataTables section.

Customizing Your Workspace
The Content Creator attempts to size and position the windows within your workspace to best fit the 
orientation of the content and the size of the screen. If necessary, you can easily resize, hide, dock, and 
undock the windows and save the changes to your own custom layout.

To save your current workspace:

Choose WINDOW > SAVE CURRENT LAYOUT.
Enter a name for your new layout, and click OK.

To load an existing workspace:

Choose WINDOW > LOAD WINDOW LAYOUT.
Select the desired layout from the sub-menu.

Using the Media Window
This section describes how to use the Toolbox elements located at the top-left of the Media Window. 
Toolbox elements are shown below:

Subsequent sections explain how to perform these tasks in the media window:

Importing assets (see Importing Assets into Content Creator)
Drawing shapes (see Creating Shapes)
Adding text (see Creating Text Fields)
Scrolling your content (see Scrolling Your Content)

https://doc.haivision.com/display/CS5v2/Working+with+DataTables
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Using the Media Window Selection Tool
The toolbar along the left side of the media window (refer to the previous graphic) provides various tools 
for adding new assets or manipulating the assets in your content. You can use the Selection Tool to 
select, reposition, resize, and rotate assets in the media window.

To select an asset in the media window:

Select the Selection Tool.
Click the asset in the media window or in the timeline.

To reposition an asset in the media window:

Select the Selection Tool.
Click and drag the asset in the media window (or in the timeline) to the position you want to set.

To resize an asset in the media window:

Select the Selection Tool.
Click the asset (in the media window or in the timeline) to select it.
Click and drag on one of the selection box handles. Hold SHIFT to constrain both dimensions.

To rotate an asset in the media window:

Select the Selection Tool.
Click the asset (in the media window or in the timeline) to select it.
While holding down the CTRL key, click and drag on one of the selection box handles.

Using the Media Window Zoom Control
If your content does not fit within the media window, you can zoom in or out to make it fit.

To resize your content within the media window:

Select a zoom percentage from the ZOOM pull-down menu. You can also click in the Zoom box and 
enter a custom zoom level.

Setting Display Options in the Media Window
At the top of the media window, you can pull down the Options menu to set the following display 
options:
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Show Selection Handles — When this option is selected (checked), some elements might display 
selection handles or other GUI elements to help you manipulate them interactively in the media 
window. You can hide the elements if you want to view the content as it appears when played 
using CoolSign Network Manager. (These elements are automatically hidden for you during content 
playback.) To hide GUI elements, uncheck Show Selection Handles.
Show Media Info — When this option is selected (checked), the media window displays the 
filename, resolution, and frame rate for each imported bitmap, video, or flash asset.
Show FPS — When this option is selected (checked), displays system performance information in 
the top-left corner of the media window. Information includes the frame rate per second as well as 
CPU and memory usage.
Toggle Full Screen — When this option is selected (checked), displays the media window in full-
screen mode, hiding all other functions of the Content Creator. To exit full screen mode, press 
Alt+Tab.
Dump Trace — When this option is selected, saves and stores a diagnostic log of recent activity at: 
C:\Users\user_name\AppData\Local\CoolSign\Content Creator\Logs
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Content Creation Basics
Importing Assets into Content Creator

Importing Bitmaps into your Project
Creating Interactive Content
Importing Layered Adobe Photoshop Files Into Your Project
Importing Video Into Your Project
Importing Flash Into Your Project

Creating Shapes
Creating Text Fields

Setting Text Layout Properties
Setting Drop Shadow Properties
Setting Interactive Properties

Importing Assets into Content Creator
This section explains how to import static images, digital video, and Flash files into your project.

All asset types have the following properties:

Name — By default, the asset's name matches that of the imported file. You can change the asset 
name to a more appropriate name if desired.
Size — The width and height of the asset, respectively. You can click in the Size boxes to resize an 
imported asset.
File Name — The full path to the file used for the asset.
File Size — The disk size of the imported file.

You can also define an asset's layout properties:

Scale Mode— You can select Fill or Letterbox to change the appearance of the asset when its size 
differs from the size of the media that it contains.
Anchor Point — If the scale mode is not Fill, you can click one of the nine boxes to control whether 
the media remains centered or floats to a particular side of the bounding box.

Other properties are specific to the type of asset. For details, see the following discussions:

Importing bitmaps (see Importing Bitmaps into your Project).
Importing video (see Importing Video Into Your Project).
Importing Flash files (see Importing Flash Into Your Project).



www.haivision.com

CoolSign 5.2
Content Creator User's Guide

17 Generated on: 2024-02-01 00:41:51
HVS-ID-CC-CS-5.2

•
•
•
•
•

1.
2.

1.

2.

Importing Bitmaps into your Project

Supported Bitmaps

Content Creator supports 32-bit images in the following formats:

Adobe Photoshop (*.psd)
JPEG (*.jpg)
Windows Bitmap (*.bmp)
Portable Network Graphics (*.png)
Graphics Interchange Format (*.gif)

If the image contains an alpha channel, the black areas of the alpha channel are transparent.

Importing Bitmaps

To import a bitmap into your project:

Choose ASSETS > IMPORT FILE...
In the dialog box, select the asset file to import.

Editing Bitmaps

To edit bitmap properties:

Select the bitmap in the media window or in the timeline to display the Bitmap properties window.

In addition to the properties that are common to all assets (name, size, file name, and file size), 
bitmap assets have the following property:
           Image Size — The original unscaled size of the imported file.
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You can set properties to add a soft drop shadow to bitmap assets:

Show drop shadow — When checked, show a drop shadow on the selected asset.
Blur — How soft the drop shadow should be.
Opacity — The opacity of the drop shadow effect.
Color — The color of the drop shadow.
Offset — The offset in pixels that the drop shadow should be positioned.

If you are building interactive content, you can specify the content to play when this shape is 
clicked.

 

Hit Link The name of the content to play when this shape is clicked.
To specify multiple pieces of content, separate the names with semicolons.

Creating Interactive Content
In the following example, Hit Link content has two link areas (Link to Item 1 and Link to Item 2) that when 
clicked, triggers the appropriate content item to play. 

All interactive content using the Hit Link feature needs to be scheduled in the channel using the CNM 
Channel Manager. In the previous example, the Simple Menu content also has to be scheduled.

Important

The requested content must be scheduled within the channel. It can be disabled, so that it 
only plays if someone clicks a Hit Link, but it does need to be in the channel.


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Once scheduled, the Hit Link content plays. In this case, Item 1 for 15 seconds and Item 2 for 5 seconds.

The Hit Link content must be disabled; otherwise, it will play continuously. When disabled, the Hit Link 
content only plays when clicked.
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1.
2.

The home content plays as scheduled and items 1 and 2 play only when clicked.

Importing Layered Adobe Photoshop Files Into Your Project

To import a layered Photoshop file into your project:

Choose ASSETS > IMPORT PHOTOSHOP WITH LAYERS...

Importing Video Into Your Project

Supported Video Formats

Content Creator supports the following digital video formats:

MPEG-4 (*.mpg or *.mp4)
MPEG-1 (*.mpg)
AVI (*.avi)
Windows Media 9 (*.wmv)
H.264 (*.mov files created using the H.264 compressor/codec).

Importing Video

To import a video into your project:

Choose ASSETS > IMPORT FILE...
In the dialog box, select the asset file to import.

Editing Video

To edit video properties:

•
•

Important

The Photoshop file must be a 16-bit or 32-bit RGB-type file. The following are not supported:
Layer effects and adjustment layers.
Grouping layers into folders in the Photoshop Layer window.


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Select the video asset in the media window or timeline to display the Video properties window:

 
In addition to the properties that are common to all assets, video assets have the following 
properties:

Duration — The duration of the imported movie.
Original Size — The original unscaled size of the imported movie.
Orientation — The orientation at which the movie was authored. You can use the pull-down 
menu to change the orientation.
Loop video playback — When checked, forces the video to loop continuously while the content 
is playing. This is only useful if the duration in timeline is greater than the length of the video 
asset.
Hit Link — If you are building interactive content, you can specify the name of the content to play 
when this video is clicked. To specify multiple pieces of content, separate the names with 
semicolons. To specify the region in which to play the content, include the @ sign. For an 
example of this usage, see the description of "Hit Link".

The requested content must be scheduled within the channel. It can be disabled, so that it only plays if 
someone clicks a Hit Link, but it does need to be in the channel.

Importing Flash Into Your Project
You can import Shockwave Flash (SWF) files exported from Adobe Flash or Adobe Live-Motion. 
ActionScript-driven Flash is supported if you enable the Timeless option.

To import a Flash file into your project:

Choose ASSETS > IMPORT FILE...
In the dialog box, select the asset file to import.
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To edit flash properties:

Select the flash asset in the media window or timeline window to display the Flash Properties 
window:

 

Verify that the name of the Flash content does not contain any of the special characters that are 
disallowed in file names (/ \ : , etc.).
In addition to the properties that are common to all assets, Flash assets have the following 
properties:

Duration — The duration of the imported SWF.
Loop Playback — When checked, forces the SWF to loop continuously while the content is 
playing.
Show Transparency — When checked, whatever areas of the Flash file were designed to be 
transparent are rendered with a transparent background. Checking this box has no visible effect 
if the Flash file contains no transparency.
Timeless — When checked, ignores the Flash asset's timeline.
Use Legacy Flash Player — When checked, provides backward compatibility for SWF files earlier 
than Flash 4.
Hit Link — If you are building interactive content, you can specify the name of the content to play 
when this video is clicked. To specify multiple pieces of content, separate the names with 
semicolons. To specify the region in which to play the content, include the @ sign. For an 
example of this usage, see the description of Hit Link.

Alternatively, you can set up the hit link via an ActionScript call. For details, see the Creating Shapes. 

Tip

If you set the background color of an SWF movie to #0000FF (R:0 G:0 B:255), it is treated as 
transparent with CoolSign.


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Creating Shapes
The Content Creator provides a rectangle shape tool and ellipse shape tool for creating basic shapes in 
your content. The shapes can be set with a fill color, a stroke color, and a stroke width.

To create a rectangle shape tool:

Select the rectangle shape tool.
Click and drag in the media window to create the rectangle. Hold down SHIFT to constrain the 
shape to a square.

To create an ellipse shape tool:

Select the ellipse shape tool.
Click and drag in the media window to create the ellipse. Hold down SHIFT to constrain the shape 
to a circle.

To edit shape properties:

Select the shape in the media window or timeline to display the Shape Properties window:
Name — The name of the shape as it appears in the timeline and script.
Type — The type of shape.
Size — The width and height of the shape, respectively.
Fill Color — The color that is used to fill the interior of the shape.
Stroke Color — The color that is used to stroke the outline of the shape if the Stroke Width is 
greater than zero.

Important

The requested content must be scheduled within the channel. It can be disabled, so that it only 
plays if someone clicks a Hit Link, but it does need to be in the channel.


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Stroke Width — Sets the width of the line that is used to stroke the outline of the shape. Setting 
the stroke width to zero removes the stroke.
Hit Link — If you are building interactive content, you can specify the name of the content to play 
when this video is clicked. To specify multiple pieces of content, separate the names with 
semicolons. To specify the region in which to play the content, include the @ sign. For an 
example of this usage, see "Creating Interactive Content".

Creating Text Fields
CoolSign Content Creator enables you to create text fields in your content. Text fields can contain either 
static text or be bound to a data table when creating dynamic content.
 

To create a text asset:

Select the text tool.
Click and drag in the media window to create the text asset.

To edit text field properties:

Select the Selection Tool.
Click the text asset in the media window or timeline to display the Text Properties window:

Name — The name of the text asset.
Text — The text string that is displayed in the text field. Click the ellipsis (...) button to open a 
multi-line text editor if you want to enter multiple lines of text.
Expression — You can enter a JavaScript expression to set the value of the text.
Font — You can set any TrueType or PostScript font that is currently installed on your system.
Style — You can toggle the style buttons to make your text bold, italicized, or underlined.

Size — The maximum point size of the text. The actual point size might be smaller if Resize text 
to fit is checked.
Color — Specifies the fill color for the text.
Tracking — Sets the spacing between each character in the text. The tracking can range from 
-100 to 100.
Leading — Sets the spacing between each line in the text. The leading can range from -100 to 
100.

Important

The requested content must be scheduled within the channel. It can be disabled, so that it only 
plays if someone clicks a Hit Link, but it does need to be in the channel.



Tip

CCT content is not HTML. While the CoolSign Media Player does support an Italics 
property on each text asset, there is no support for making part of a text asset italic using 
an expression. As a workaround, separate the text/data that you want to be italicized from 
the other text/data that should not be italicized, and bind each of those to two or more 
separate assets. Then, you can enable the Italics property on the entire text asset as 
desired.


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Setting Text Layout Properties
You can define properties that determine how your text should be laid out within the text bounding box. 
This is especially useful when you are creating dynamic data fields where you don't have control over 
exactly what text might be shown.

H-Align, V-Align — Specifies the horizontal and vertical alignment of the text within the bounding 
box. You can set both.
Trimming — Defines how the text box should wrap or crop text that is wider than the bounding 
box. When Wrap is checked, trimming defines where the text should break for the next line. If Wrap 
is not checked, trimming defines where the text should be cropped. Trimming has no visible effect 
when Wrap is off and Scale down text to fit is on.
Wrap — When checked, forces text to wrap to multiple lines if the text doesn't fit on a single line. 
The Trimming and Resize text to fit properties determine how text is wrapped.
Resize text to fit — When checked, forces the text to fit within the bounding box by decreasing the 
font size if necessary. Text only resizes after accepting any trimming or wrap properties.
Boundary — Sets the width and height of the text field. You can also set these values by resizing 
the text field in the media window ("Using the Media Window Selection Tool").
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Setting Drop Shadow Properties
You can set properties to add a soft drop shadow to text assets:

Show drop shadow — When checked, show a drop shadow on the selected asset.
Blur — How soft the drop shadow should be.
Opacity — The opacity of the drop shadow effect.
Color — The color of the drop shadow.
Offset — The offset (in pixels) of the drop shadow.

Setting Interactive Properties
Hit Link — If you are building interactive content, you can specify the name of the content to play when 
this video is clicked. To specify multiple pieces of content, separate the names with semicolons. To 
specify the region in which to play the content, include the @ sign. For an example of this usage, see 
"Creating Interactive Content".

Important

The requested content must be scheduled within the channel. It can be disabled, so that it only 
plays if someone clicks a Hit Link, but it does need to be in the channel.


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1.

Advanced Content Creation
Topics Discussed

Scrolling Your Content
Playing Your Content Back
Using the Timeline Window

Changing the Layer of Assets in Your Content
Setting the Start and Stop Time of Assets
About Transform Properties
Editing Transform Properties
Interactively Editing Transform Properties

Animating the Transform Properties of an Asset
Understanding Keyframe Auto-Creation
Editing Keyframes
About Keyframe Interpolation Modes
Setting Post-Interpolation Modes

Using Templates
Using Data Tables

Understanding Data Tables
Understanding Data Fields
Using the Data Tables Window
Creating a Data Table
About Character Masking
Importing a Data Table from a CoolSign Network
Filtering Your Dynamic Data
Sorting How Your Data Displays
Entering Sample Data Into Your Data Table
Ordering Your Sample Data
Printing Sample Data

Using Dynamic Data in Your Content
Creating Data Fields
Viewing Sample Data in Your Data Fields
Using Data Panels
Editing Data Panel Properties
Setting Data Panel Layout Properties
Setting Data Properties
Adding Expressions to Transform Properties

Scrolling Your Content
The Content Creator provides a Scroll Tool that you can use to move other assets across the screen at a 
consistent speed. One common use of this tool would be to implement a scrolling ticker.

To create scrolling text:

Select the scroll tool.
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Click and drag in the media window to define the dimensions of the scroll control. You can 
subsequently modify the dimensions in the Scroll Properties window.
Select the scroll control in the media window or timeline to display the Scroll Properties window:

Name — The name of the scroll control as it appears in the timeline and script.
Size — The dimensions (in pixels) of the scroll control.
Fill Color — The color that is used to fill the interior of the scroll control. To specify a transparent 
scroll control, select the Web tab (in the color selector) and click Transparent.
Stroke Color — The color that is used to stroke the outline of the scroll control if the Stroke 
Width is greater than zero. To specify a transparent scroll control, select the Web tab (in the 
color selector) and click Transparent.
Stroke Width — Sets the width of the line that is used to stroke the outline of the scroll control. 
Setting the stroke width to zero removes the stroke.
Pick Scrolling Assets — Displays the Pick Scrolling Assets dialog. See Setting Interactive 
Properties for more details.
Horizontal Speed — The speed (in pixels per frame) with which all scrolling assets move across 
the screen horizontally. To scroll to the right, define a positive horizontal speed. To scroll to the 
left, make this a negative value.
Vertical Speed — The speed (in pixels per frame) with which all scrolling assets move across the 
screen vertically. To scroll down, define a positive vertical speed. To scroll up, make this a 
negative value.
To scroll diagonally (in multiple dimensions), define both a horizontal and vertical speed.
Horizontal Spacing — When scrolling multiple assets across the screen, this value sets the 
number of pixels that separate each asset horizontally.
Vertical Spacing — When scrolling multiple assets across the screen, this value sets the number 
of pixels that separate each asset vertically.
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Only scroll one asset at a time — Check this box to limit the scroll control to a single asset at a 
time. The next asset does not appear on the screen until the current asset has completely exited 
the scroll control's boundaries.
Repeat assets continuously (ticker mode) — Check this box to scroll assets continuously, as with 
a stock ticker. The ticker clones one set of the assets for each row in the data table.
End playback after scrolling last row — Check this box to cause the entire piece of content to 
end playback as soon as all rows in the data table have been displayed in the ticker and have 
finished scrolling off the end of the screen. In the AdPlayer, this causes the next item in the 
channel schedule to begin to play.
Hit Link — If you are building interactive content, you can specify the name of the content to play 
when this scrolling element is clicked. To specify multiple pieces of content, separate the names 
with semicolons. To specify the region in which to play the content, include the @ sign. For an 
example of this usage, see Creating Interactive Content.

To select scrolling assets:

Click the Pick Scrolling Assets button in the Scrolling section of the Scroll properties window.

In the Pick Scrolling Assets dialog, perform the following actions as required:
To select an asset that you want to scroll, click to select the asset from the list of available assets 
(on the left), then click the > button.
To select all available assets, click the >> button.
To remove an asset from the list of scrolling assets, click to select it in the list on the right, then 
click the < button.
To remove all assets from the scrolling list, click the << button.

Important

The requested content must be scheduled within the channel. It can be disabled, so that it 
only plays if someone clicks a Hit Link, but it does need to be in the channel.


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To reorder the assets in the list on the right, use the up and down arrow buttons.

 

The following limitations apply to scrolling:

Only text, shapes, and images (not videos) can be scrolled. Text and images can be static, or they 
can be dynamically retrieved from the data table.
You cannot scroll another scroll control.
You cannot scroll an asset that is already assigned to another scroll control in the same project. 
You must first remove an asset from its current scroll control before you can add it to a different 
scroll control.
You cannot scroll an individual data field that is assigned to a data panel.

After exiting the scroll control, the scrolling asset remains visible. To hide an asset that has exited the 
scroll control, you might want to superimpose a black box, JPEG, or other image.

Playing Your Content Back
The playback controls at the top of the timeline window can be used to play, pause, frame advance, 
frame rewind, and jump to the beginning or end of the content. The loop button can be toggled for 
looping playback. The current time of the content is displayed in the time field.

 

Note

You can hold down the frame advance or frame rewind button to advance or rewind the content at 
a speed of five frames per second.


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To start playing your content:

Click the Play button in the timeline window.

or

Select the menu item Playback > Play.

To jump to a specific time in your content:

Click the time field to display the Go To Time dialog. Or, select PLAYBACK > GO TO TIME.

 
 
Enter the time to jump to.
Click OK.

To scrub to a specific time in your content:

Click and drag the time slider to the desired time.

Using the Timeline Window

Changing the Layer of Assets in Your Content
Each asset of your content is listed in the timeline window in the order from top to bottom. Assets at the 
top of the list appear in your content composite above the assets that are below them in the list.
 

To change an asset's layer:

Note

The timeline refers to the length of time over which the content is played, and not the time of day 
scheduled for playback. For information on scheduling, see "About Scheduling" in the CoolSign 
Network Manager User's Guide.



https://doc.haivision.com/display/CS5v2/About+Scheduling
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From the timeline window, click and drag the asset name above or below the other assets in the 
timeline window.

To bring an asset to the front:

Select LAYOUT > BRING TO FRONT.

To send an asset to the back:

Select LAYOUT > SEND TO BACK.

Setting the Start and Stop Time of Assets
Each asset can be set with a start and stop time. Assets are not visible before and after their start and 
stop times.

To set the start or stop time of an asset, do one of the following:

Click and drag on the left or right handle of the asset's time bar to set the start or stop time.
Edit the start or stop time in the timeline window.

About Transform Properties
Every asset has a set of transform properties that can be animated. To expand the asset's transform 
properties, click the + button to the left of the asset's name. 

Every asset has the following transform properties:

PositionX — Horizontal position of the center of the asset relative to the center of the stage (in 
pixels).
PositionY — Vertical position of the center of the asset relative to the center of the stage (in pixels).
Rotation — Rotation of the asset in degrees.
ScaleX — Percentage that the asset is scaled in the horizontal dimension.
ScaleY — Percentage that the asset is scaled in the vertical dimension.
Opacity — Percentage of transparency applied to the asset, ranging from 0% (invisible) to 100% 
(fully visible).
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For some asset types, additional transform properties are available:

FillColor — Color used to fill the asset. Available for shape and text assets.
StrokeColor — Color used to stroke the asset. Available for shape assets only.
Volume — Volume of embedded audio track. Available for video and Flash assets only.

Editing Transform Properties
You can numerically edit the value of a transform property if you know the exact value you want to set.

To numerically edit the transform properties of an asset:

Click the Expand/Collapse  button to expand the transform properties for the asset.
Click the Value of the transform property you want to edit.
Type a new value into the field.
Press Enter or click off the field.

Interactively Editing Transform Properties
You can interactively adjust an asset's transform properties and immediately see the changes in the 
media window.

To interactively edit the transform properties of an asset using the mouse:

To interactively adjust the value of a transform property, click and drag horizontally on the 
property name. Drag to the left to decrease the value and drag to the right to increase the value.
You can also click and drag the asset within the media window.

To interactively edit the transform properties of an asset using the keyboard:

Select the transform property you want to edit in the timeline window.
Do one of the following to:

Increment or decrement the value by 1, press either the left or right arrow keys as appropriate.
Increment or decrement the value by 10, hold down the CTRL key while pressing either the left or 
right arrow keys as appropriate.

Animating the Transform Properties of an Asset
You can animate the transform properties of your assets by setting keyframes. A keyframe establishes 
the value of the property at a specific point in time. If you define multiple keyframes, the keyframe 
interpolation mode determines how the value of the property is interpolated over time — that is, how the 
property is animated between two adjacent keyframes. For more about interpolation modes, see About 
Keyframe Interpolation Modes.

To create a new keyframe for a transform property:

In the timeline window, select the transform property for which you want to set a keyframe.
Set the value of the transform property to the value you want the keyframe to use.
Position the time slider to the time at which you want to create the keyframe.
Right-click on the property name or in the keyframe area and choose Add new keyframe.
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Understanding Keyframe Auto-Creation
Once you have set a keyframe for a transform property, the property is now animated. If you change the 
value of an animated property, one of two things can occur:

If the time slider is set to the same time as an existing keyframe, the value of that keyframe is 
updated to reflect the new transform property value.
If no keyframes are defined for the current time of the content, a new keyframe is automatically 
created with the transform property value at the current time.

Editing Keyframes
You can edit the value of an existing keyframe, move the keyframe in time, or delete keyframes.

To edit the value of an existing keyframe manually:

Set the time slider to the same time as the keyframe.
Enter the desired value into the transform property.

To edit the time of an existing keyframe:

In the timeline window, click and drag the keyframe to the new time.

To edit the value and time of an existing keyframe numerically:

Do one of the following:
Double-click on the keyframe.
Right-click on the keyframe and choose EDIT KEYFRAME. The Edit Keyframe dialog appears:

Edit the keyframe time, value, or interpolation mode.
To navigate through other keyframes without having to close the Edit keyframe dialog, use the 
right and left arrow buttons in the Edit keyframe dialog.
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To select multiple keyframes in the timeline window — for example, the start and end values of 
the specific transform property — hold down the Shift key while selecting. You can then drag the 
selected values to the new location.

Click Close.
 

To delete a keyframe:

In the timeline window, right-click on the keyframe and choose DELETE KEYFRAME.
 

To delete all keyframes for a transform property:

In the timeline window, right-click on the property name or in the keyframe area.
Then, choose CLEAR ALL KEYFRAMES.

About Keyframe Interpolation Modes
CoolSign Content Creator currently provides two types of keyframe interpolation modes that set how a 
property is animated between two keyframes:

Linear — (Default) The property changes linearly from one keyframe to the next. 

Hold — The property holds at the first keyframe and immediately pops to the second keyframe 
value.

To edit the keyframe interpolation mode:

Do one of the following:
Double-click on the keyframe.
Right-click on the keyframe and choose EDIT KEYFRAME.

Select a new interpolation mode.
Click Close.
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Setting Post-Interpolation Modes
By default, when you set keyframes for a property of an asset, the value of the last keyframe is held 
throughout the remainder of the content. There are a number of alternative post-interpolation modes 
that you can set to define how animation is interpolated after the last keyframe. The following post-
interpolation modes are available:

Hold (Default) — The value of the last keyframe is held constant.

 
Extend — Extrapolate the slope between the last two keyframes so that the value continues at the 
same rate.

  
Mirror — Loop back and forth through all the set keyframes.

  
Cycle — Loop forward through all the set keyframes from the beginning.

Using Templates
Templates are a recent addition to CoolSign. Consequently, you might need to create a new project to 
specify that it is a template.

Templates can only be created using the CoolSign Content Creator. A template is basically a 
standardized layout that can be modified in only a specified manner. In CoolSign Content Creator, the 
Content Designer uses a data table and data table elements to specify what can be modified. Once the 
template has been created, the Content Designer publishes it to the CoolSign Content Creator and it is 
available for use in the web-based interface under the Templates tab.

Creating a Template
To create a template:

Create a new project, and select TEMPLATE for the Project Type.
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Fill out the remaining project settings as you would normally.
When the project workspace opens, create the content that you want. See Importing Assets into 
Content Creator.

 
 
Next, create a data table with data fields for the content elements that you want to be able to edit 
in the template. See Using Data Tables and Using Dynamic Data in Your Content for information on 
this.

Important

If you imported Photoshop asset that included layered elements that you want to replace 
with a dynamic data field so that it is editable, you will need to locate the layer element in the 
Timeline window, click the + to open the element's properties and set the Opacity to 0%.


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The data fields are bound with expressions to the data table. Refer to Writing Content Creator 
Expressions for more information.
When finished, click FILE > PUBLISH TO NETWORK...
When prompted, click OK.

 
The CNM login screen appears, log in so that the content can be published.
When the files have been transferred, you can click the Templates tab in the web-based user 
interface (WUI) to verify that your template is available.

Using Data Tables
One of most powerful features in CoolSign is the ability to have your content dynamically display 
information pulled from CoolSign data tables. The CoolSign Content Creator includes specific tools for 
integrating your content with dynamic data. You can use dynamic data features to create content that 
displays product pricing, weather reports, stock quotes, sports scores and more. Data from a CoolSign 
data table can be displayed in a text field or you can display images or movies imported into a data table. 
You can also write expressions that drive the properties of an asset based on dynamic information — for 
example, setting the height of a thermometer graphic in a weather ad or changing the color of text based 
on the data displayed.

Understanding Data Tables

 

Note

When you subsequently import the content into CNM, only the structure of the data table is 
imported; none of your sample data is filled in. You must use CNM to populate the data tables with 
the actual data.


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Understanding Data Fields
In order to show dynamic data in your content, you need to create data fields for the data to be 
displayed in. Data fields are bound to the data in a CoolSign data table with binding expressions. Binding 
expressions are automatically generated when you create a data field, but they can be edited or created 
from scratch for more complicated bindings. A data field can either directly display the text from a data 
table or it can display an image or other media asset that the data table contains.

Using the Data Tables Window
The Data Tables window enables you to manage the data tables in your content. You can add a new 
empty data table to your project with no fields or sample data. You can then define fields and add sample 
data. When you import your content into a CoolSign network, the data table is automatically created and 
bound for you. For more details, see:

Creating a Data Table
Working with DataTables
Editing Data in a Data Table
Entering Sample Data Into Your Data Table

Creating a Data Table
To add a new data table to your project:

In the Data Tables window, click New...

 
The Data Table dialog opens.

https://doc.haivision.com/display/CS5v2/Working+with+DataTables
https://doc.haivision.com/display/CS5v2/Editing+an+Existing+DataTable
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Enter a name for the new data table.
To add a field to the new data table, click Add.

 
The Field Properties dialog appears.
 
Enter the name of the new field in the Field Name text box.

Text — Enables any alphanumeric characters, including the letters A-Z (upper and lower case) 
and number 0-9. Used for basic or European text.
Number — Enables numeric entry using a spin edit control.
Boolean — Enables boolean entry of True/False.
Date & Time — Enables both date and time entry.
Date — Enables date entry using a date/time picker control.
Time — Enables time entry using a time control.
Media — Enables import of an image, movie, or flash media asset.
Long Text — Enables memo-style text entry for long fields.

Note

See "About Character Masking" for a list of meta-characters, special characters, and literal 
characters that can be used when restricting field entries.


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International Text — Enables text that is not European. This refers to UTF-8 support (8bit UCS/ 
Unicode Transformation Format). UTF-8 is a variable-length character encoding for Unicode. It is 
able to represent any character in the Unicode standard, yet is backwards compatible with ASCII.
 

In the Default Value text box, enter the default value to use when a new row is added to the data 
table.
Set any desired constraints on what can be entered into the data field:

Use Picklist (Text only) — Displays the text field using a combobox where you can select from a 
list of pre-defined values. You can enter one or more pre-defined values in the picklist text box 
separated by carriage returns.
Allow Editing (Text only) — Enables you to enter custom values in addition to the values 
available from the picklist option.
Limit Chars (Text only) — Limits the maximum number of characters that can be typed into a 
text field.
Char Mask (Text only) — Restricts which characters can be entered into a text field.

Examples:

A mask for entering a telephone number: (000)000-0000. Each zero (0) metacharacter in this 
mask requires a numeric character in the corresponding position. No characters can be omitted. 
Note that the "-", "(and)" characters in the mask are literals. Following are images of an editor that 
uses this mask:

A mask for entering a telephone number with an optional area code: (999)0000000. The "9" 
metacharacter enables you to omit the area code part of a phone number.

A mask for entering an alpha-numeric sequence: \A>LL-00. The "\A" stands for the literal character 
"A". Since "A" is used as a metacharacter, the backslash must be used to make "A" appear as a 
literal. The ">" command specifies that the following text should be in uppercase. The "LL" 
substring indicates that two alphabetical characters should be inserted in this position. The "00" 
substring is a placeholder for two digits.

Force Case (Text only) — Forces the case of all characters to either upper or lower case.
Only allow values from (Number only) — Enables setting the minimum and maximum value of a 
number field.
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Media Type (Media only) — Sets the type of media that can be imported into a media field.

Image Constraint (Media only) — When checked, importing images display a special dialog that can 
be used to crop and scale the imported image to fit the defined resolution. When checked, causes a 
dialog to appear when you import an image, giving you the opportunity to crop and scale.

Click OK .
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To add another field, repeat steps 3. through 8.

When you're done, click OK to close the Data Table Properties dialog. The Data Tables window now 
includes the fields that you've just added.

You can now:

Import a data table from a CoolSign network.
Create a filter expression on your data table to limit the records to display.
Set the sorting order in which data from the table is displayed.
Populate the data table with sample data so that you can preview how your content looks like 
when actually playing.

To edit a data table structure:

In the Data Tables window, click Edit...

Click OK.

About Character Masking
Metacharacters—used to represent a range of symbols. You can enter text only in the positions that 
correspond to metacharacters. When a metacharacter is found at a specific position in the mask you can 
enter any character from the related range in this position in the edit box. The following table lists the 
available metacharacters: 

Character Meaning

L Requires an alphabetic character in this position. For the United States, this 
is A- Z, a-z.

Note

You can also modify existing data structure elements (such as the data table name and data 
fields).



Note

For detailed information about the available properties and data table field settings, see 
Creating Data Fields.



https://doc.haivision.com/display/CS5v2/Importing+and+Exporting+Data
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l Permits only an alphabetic character in this position, but doesn't require it.

A Requires an alphanumeric character in this position. For the United States, 
this is A-Z, a-z, 0-9.

a Permits only an alphanumeric character in this position, but doesn't require 
it.

C Requires an arbitrary character in this position.

c Permits an arbitrary character in this position, but doesn't require it.

0 Requires a numeric character in this position.

9 Permits only a numeric character in this position, but doesn't require it.

# Permits only a numeric character or a plus or minus sign in this position, 
but doesn't require it.

Special Characters—used to control the case of the input string and to represent various delimiters and 
currency symbols. 

Character Meaning

> If a > character appears in the mask, all the characters that follow it are in 
upper- case until the end of the mask or until a < character is encountered.

< If a < character appears in the mask, all the characters that follow it are in 
lower- case until the end of the mask or until a > character is encountered.

<> If these two characters appear together in a mask, no case checking is 
performed and the data is formatted with the case you use during data entry.

/ A / character is used to separate the months, days, and years in dates. If the 
char- acter that separates the months, days, and years is different in the 
regional settings of the system that the application runs on, that character is 
used instead.

: A : character is used to separate the hours, minutes, and seconds in time values. 
If the character that separates the hours, minutes, and seconds is different in 
the regional settings of the system that the application runs on, that character is 
used instead.

$ A $ character is used to designate currency values. If the character that 
designates the currency values is different in the regional settings of the system 
that the appli- cation runs on, that character is used instead.

Literal Characters —A character that is neither a metacharacter nor a special character is called a literal. 
Literals are inserted automatically as is into the edit box in their positions defined by the mask. There is 
no need to enter literal characters, the cursor skips over them during editing.

Note

Metacharacters and special characters can also appear as literal characters if they are preceded by 
a backslash (\). 


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Importing a Data Table from a CoolSign Network
If the data table for which you are creating content already exists, you can import it from a CoolSign 
network instead of creating it from scratch. This is especially useful if the content you are creating is 
bound to a data table that is created by an external data source like the CoolSign DataFeed or 
DataWatcher. When you import a data table, its current data values are imported as sample data.

To import a data table from a CoolSign network:

In the Data Tables window, click Import...
If you haven't yet connected to a network, the standard CNM login dialog appears.
Select the data table you want to import from the list of available data tables.
Click OK.

Filtering Your Dynamic Data
Often, you'll want to filter which rows in a data table that appear in your content. You can create a filter 
expression on your data table to limit the records to display.
 

To display the Set filter dialog:

In the Data Tables window, select the Properties tab for your data table.

 
 
Click the ... button to open the Set filter dialog.

 

Field — Select the field from your data table that you want to use in your filter criteria.
Condition — Select the condition that you want to use to compare the selected field against the 
criteria.
Value — You can manually enter a value to compare a field against.
Attribute — If you want to filter against an attribute of the node on which the content is playing, 
you can either enter the attribute name into the Attribute text box or you can click Select 
attribute to connect to a CoolSign Network and choose an attribute that exists on that network. 
Filtering against an attribute is useful when you want to localize the dynamic data in your 
content.
Default Value — If you've selected to filter against an attribute, you can enter the value of the 
attribute for previewing within the Content Creator. When your content is played back on a 
CoolSign player, the filter uses the value of the attribute for that player.
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Edit filter script — By default, this dialog opens with a simple interface that enables you to define 
your filter criteria. For more advanced filter expressions, you can check this box to display a field 
into which you can directly type a JavaScript filter expression.
Clear Filter — Click this button to reset your filter to display all available rows.

Sorting How Your Data Displays
From the Data Tables window, you can set the sorting order in which data from your data table appears. 
This is useful when you are displaying data using a table-like format or if your content is looping to show 
multiple rows of data. There are two special sort orders:

InOrder — No additional sorting is applied to the data.
Shuffle — Rows are sorted randomly each time the content plays.

To sort your data based on a specific column, click the column header (or select the column from the Sort 
by menu). You can also click the Ascending or Descending radio button to determine the sort order.

Entering Sample Data Into Your Data Table
You might want to preview your content with sample data in the data table so you can see what it looks 
like when actually playing and to make sure that your design supports the different data that can be 
entered.
 

To add a new row to the sample data:
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In the Data Tables window, click Add Row.

 
Click in the column and row you want to edit.
Do one of the following:

Type a new value.
Use the column editor controls to edit the field value.

For example, use the column editor controls to edit an image field. When you define a data table field 
(such as the quantity) you can add a field and set it to each field type, which might have a column editor 
associated with it. If you create a field date and time field and then add a value, you get a drop-down 
menu column editor that shows you a calendar. Once you create a field you'll see the column editor 
controls associated with that field.

To delete a row from the sample data:

Select the row you want to delete by clicking in any field.
Click Delete Row.

Ordering Your Sample Data
Every data table has a special ordering index field that determines the order of a row within the data. By 
default, the ordering field is not visible.

To display the ordering field:

In the data table's sample grid, right-click anywhere to display the popup menu.
Select Show Ordering to toggle the visibility of the ordering field.



www.haivision.com

CoolSign 5.2
Content Creator User's Guide

48 Generated on: 2024-02-01 00:41:51
HVS-ID-CC-CS-5.2

1.

1.

Printing Sample Data
You can print your sample data or save it to PDF or graphic files.

To do so, choose Print Data from the sample grid's pop up menu.

Using Dynamic Data in Your Content
You can use data from a data table in your content in either of two ways: data fields or property 
expressions.

Creating Data Fields
As described previously, a data field can either directly display the text from a data table or it can display 
an image or other media asset that the data table contains.

To add a data field to your content:

Select the data field tool from the toolbar.
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Click and drag in the media window to lay out the position and size of the data field.

 
If you have not already added a data table to your project, the Create DataTable dialog appears, 
prompting you to create a new data table or import an existing data table from an available 
CoolSign network (see Using Templates).
After creating a new data table, or if a data table already exists in your project, the New Data Field 
dialog appears.

Do one of the following:
Select a field from the field list.
Click New Field to create a new field in the data table.

Click OK. If the field you selected is a media field, a media data field is automatically created; 
otherwise, a text data field is created.

Viewing Sample Data in Your Data Fields
If you've entered sample data into your data table, that data is used to populate your data fields using 
whatever filter and sort properties you might have set. If there is no sample data in your data table, or if 
your filter expression does not return any data, the data field displays the name of the field to which it 
was bound.

Using Data Panels
A data panel is a special grouping of data fields that can be used to aid when creating content that 
displays multiple rows of data in a table-like format. For example, if you are creating content that appears 
in multiple rows of data from a sports score data table, it would be very tedious to have to add a data 
field for each field and row you wanted to display. Data panels enables you to set up one panel of data 
fields and then specify how many duplicates should be created. You have total design freedom to lay out 
the fields in your data panel however you'd like. You can even animate the data fields in a data panel.

To add a data panel to your project:
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If you have not added a data table to your project, use the Create DataTable dialog to create a new 
data table or import an existing data table from an available CoolSign network (see Using 
Templates).
Select the data panel tool from the toolbar.
Click and drag in the media window to position and lay out the panel.
Indicate whether you are creating a new table or importing an existing table.

If this is a new table, give it a name.

Verify that the data panel is selected in the media window.
Select the data field tool from the toolbar.
Click and drag inside the data panel in the media window to position the data field. You can 
subsequently resize or rearrange the data fields.
When you've finished positioning your new data field, the New Data Field dialog appears

Choose the data table that is bound to this data panel.
Do one of the following:
Select a field from the field list.
Click New Field to create a new field in the data table.
Click OK.
To add another field to the data panel, repeat steps 6 through 12. Once you've added fields to your 
data panel, you can set the properties for the data panel:

Panel properties
Layout properties
Data properties

Editing Data Panel Properties
You can edit data panel properties from the DataPanel properties window:

Note

First, design the data panel that you'll create. This simplifies the task of subsequently populating 
the data panel.


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Name — Specifies the name of the data panel.
Data Table — Specifies which data table is bound to the data panel.
Start Row Index — Sets the index of the row of data to display in the first row of the data panel.

Setting Data Panel Layout Properties
Once you've added fields to your data panel, you can use the data panel layout properties to create 
additional rows and columns of fields. Use the data panel option to display one or more data field values. 
Use the data layout properties to display more than one row.

The only way to add a data field within the data panel is by creating the data field inside the data panel. 
Rows are top to bottom and columns are side by side. 

Rows — How many rows of data panels to display.
Cols — How many columns of data panels to display.
Spacing — How many pixels each row or column should be offset.
Flow Direction — How records should flow into the rows and columns of data panels.
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Child Animation Offset — The number of seconds that is used to offset any animated data fields in 
each data panel. You can use the timing offset property to stagger the animation of data fields so 
that each row animates one after another or overlapping.

You can only interact with the first row of a data panel in media window. When you transform the data 
panel by repositioning it or resizing it, all other data panel rows snap to match. If you add additional data 
fields to the data panel or remove fields, all other data panel rows synchronize to match.

Setting Data Properties
When your data table has more rows of data than you can display at once in your content, you can use 
the data properties to define what should happen. For example, you might have designed content to 
display a list of menu items for a restaurant, but you can only fit five items on the screen at a time. The 
data properties determine what to do if there are more than five menu items in the data table.

Show multiple sets of data — When checked, this data panel is enabled to show multiple sets of 
rows during a single iteration of the content. Otherwise, the data panel does not advance beyond 
the selected rows in the data table until the next time the content plays.
Set duration — How long to wait before the data panel displays the next set of rows in the data 
table. The duration also appears in the timeline for the data panel as a green timeline bar. You can 
also adjust the duration by interactively adjusting the data panel's timeline bar.
Max sets — The maximum number of times that your content can loop to display multiple sets of 
data. The data panel never shows more rows than exists in your data table, but you can define a 
maximum number of sets in case you don't want to loop through all the rows in a data table.
Auto-fit duration — When checked, your content automatically adjusts its duration to fit the 
number of rows that appear. This is extremely useful when you don't know beforehand how many 
rows of data are going to be in the data table, but want to ensure that your content plays as long 
as necessary to show all the rows.
Pad start, Pad end — When Auto-fit duration is checked, you can also add an additional pad to 
total duration of the content in case you want to display the final data row(s) for a longer period.
Always start from first row — When this box is not checked, the content remembers the last row 
that appeared the last time the content played, and begins with the next row in the data table. 
When this box is checked, the display always begins with row one in the data table.
Wrap data — When this box is checked, if there are fewer rows in the data table than there are in 
the data panel, the remaining rows of the data panel begin again with row one of the data table. 
Otherwise, the data panel is truncated after the last row of the table appears.

Adding Expressions to Transform Properties
In addition to setting binding expressions for data fields, CoolSign Content Creator also enables you to 
create expressions for the transform properties of any asset. You can use transform expressions to 
dynamically set any transform property including position, scale, rotation, transparency, or color.
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When an expression is set for a transform property, the return value of the expression determines the 
value of the property. Properties with expressions cannot be modified interactively via the media window 
or timeline window value editor. For more information on writing expressions, see Writing Content 
Creator Expressions.

To set an expression on a transform property:

Select the transform property of the asset for which you want to set an expression.
Right-click and choose Edit Expression from the pop-up menu.
Enter the expression into the Edit Expression dialog.
Click OK.

To clear an expression from a transform property:

Select the transform property.
Right-click and choose Clear expression.
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Using Expressions
Writing Content Creator Expressions

Special Content Creator Functions
Editing Expressions
Formatting Expression Results
Conditional Formatting based upon Dynamic Data

Writing Content Creator Expressions
All expressions in CoolSign Content Creator are written in JavaScript. There are numerous books and 
websites with information on programming in JavaScript. CoolSign Content Creator only processes "safe" 
JavaScript commands, so expressions cannot create windows, access the filesystem, or perform any 
other unsafe functions. When you are writing either a binding or transform expression, your expression is 
treated as a function and must return a string value as its final action. You are free to add any necessary 
logic or processing to derive the value that your expression returns and you can even have multiple 
functions defined within your expression.

Special Content Creator Functions
The Content Creator defines a number of special functions to make accessing data from data tables 
simpler from a binding or transform expression. These functions exist in the content's global expression. 

The following special functions are defined:

Note

While it is possible to edit the global expression, doing so might make the content unreadable to 
Content Creator so proceed at your own risk.


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Function GetValue (field) – Returns a string value from the data table for the given field of the data 
table. If the field name does not exist in the data table, the default value parameter is returned. 
Function GetValueAtRow (field, index) – Returns a string value from the data table for the given 
field and row index of the data table. If the field name or row index does not exist in the data table, 
the default value parameter is returned.
Function GetValueEx (field, index, timeOffset, emptyValue)
Function GetValueByFiltered (fieldToReturn, fieldToCheck, valueToCheck) – Returns a string value 
from the data table for the given field and row index of the data table. If the field name or row 
index does not exist in the data table, the default value parameter is returned.
Function FormatDateValue (value, format, defaultValue) – Returns a date field from the data table 
formatted using the format parameter.
Function FormatNumberValue (value, format, defaultValue) – Returns a number field from the data 
table formatted using the format parameter.
Function GetAttributeValue (attribute, defaultValue) – Returns the value of the attribute for the 
player on which the content is currently playing. If the attribute does not exist, the default value is 
returned.

Editing Expressions
When you create a data field, a binding expression is automatically generated for you that links the data 
field to a value in a data table. You can edit the expression for a data field or add a new expression for a 
text field with the Edit Expression dialog.

To edit the expression for a data field or text field:

Select the data field or text field in the media window or timeline to display the asset's properties 
window.

In the Properties window, click Edit expression... 

 

The Edit Expression dialog appears.
 
Use the expression builder to lay out the text as it should appear in your data field, concatenate 
multiple fields together, and format date/time or number fields.
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Expression builder — You can edit the expression builder to add additional text or special 
characters into your expression. For example, if you type an exclamation point after the bound 
field (indicated by the field name in angle brackets), then an exclamation point is always added 
in the data field regardless of what is typed into the data table.
Available fields — All the fields from your data table and any special system fields are listed here. 
You can drag a field from the list into the Expression builder to add it to your expression. You 
can use this functionality to display multiple fields within your data field. For example, you might 
have a FirstName and a LastName field that you want to display together in a single data field.
Show script editor — Check this box to edit the actual JavaScript used for the expression. You 
can enter more complicated expressions this way.
Re-evaluate expression every X seconds — Specifies how often the expression should be re-
evaluated and updated. Set to zero if you want the expression to only be evaluated once when 
the content starts playing. When you add an asset to a ticker, its expression evaluation frequency 
is set to "-1", which means that the expression is evaluated once for each row of data in the 
ticker.

Formatting Expression Results
You can define some special formatting settings for the value that is returned by your expression, 
including a default value for when no data exists and whether to force the data to upper- or lower-case.

If your data field or expression returns a number or date/time value, you might want to format how that 
value appears in the data field. The Content Creator provides a large set of pre-defined format types for 
numbers and date/time values or you can create your own custom formats.
 

To customize how the data in a field is formatted:

Right-click on the field in the Expression builder to display the popup menu.
Select Format field... to display the Set Formatting dialog:

 
Default value — Specifies the value to display when there is no data in the bound field. For 
example, you might want to show blank records with "--" or "NoData" instead of just a blank 
field.
Force case — You can use the pull-down menu to force the case of the data in a field to all 
upper-case or all lower-case.
Format value as — Specifies how to format the value of the field. When you select a format type 
other than None, the data format styles are shown. You can either select a pre-defined format 
from the list or enter a custom format. For example, if you select DateTime, the following Date 
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format styles appear:

Conditional Formatting based upon Dynamic Data
You can have objects conditionally formatted (font or shape attributes) in Content Creator depending 
upon a comparison of fields or the evaluation of a field from DataWatcher to determine the font size or 
scaling factor for specific assets (such as by fetching a value out of a datable and changing the color). 
For instance, if a field of current-stock-price is less than the field of yesterdays-stock-price turn the font 
red. If the field of current-temperature is less than the value of 32 turn the font blue.

Setting Text Color or Size based on Dynamic Data
This is done in much the same way that text from a data table is shown on screen. Only, instead of 
selecting a text asset and clicking Create Expression to open the expression builder, click the + icon next 
to the text asset in the Timeline window to view the scriptable properties for that asset. Then, right-click 
on the desired property and click Edit Expression to get an expression builder dialog where you can write 
Javascript to calculate a value for that property.

For example, to change a stock price text asset color to red or green based on the price in a data table, 
use a script similar to the following:

var price = GetValueEx("currentstockprice",rowindex,timeoffset,"");
var yesterday = GetValueEx("yesterdaysstockprice",rowindex,timeoffset,"");
if (price < yesterday)
{ return "FFFF0000"; // red 
}
else
{ return "FF00FF00"; // green 
}

The value being returned should be a hexadecimal string in ARGB format (alpha, red, green, blue).

To dynamically change the size of the text asset, create expressions on the ScaleX and ScaleY properties 
that return a number equal to the desired scaling factor. For example, return 1.5 to make the asset 50% 
larger.

https://haivision.jira.com/secure/attachment/47141/47141_contentcreator-conditional.png
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Publishing Content
Topics Discussed 

Publishing Content to a CoolSign Network

Publishing Content to a CoolSign Network
To publish content from CoolSign Content Creator to the CoolSign network:

Select the menu item File > Publish to Network.
If you haven't already saved the project locally, you'll be prompted to do so before you can publish 
the project.

To publish content from the Content Creator:

You must have Write Content capability. For details, see the "About Security" section of the CoolSign 
Network Manager User's Guide.

After verifying your login credentials, the Content Creator publishes the content to the CoolSign 
network, then disconnects you from the CoolSign network.

Using the CoolSign Content Wizard
The CoolSign Content Wizard guides you through a series of steps to convert your digital media assets 
into content that can be played back on a CoolSign Digital Media Network. At any point, you can click the 
Prev button to return to previous steps.

Important

If the content already exists on the network, it is overwritten.



https://doc.haivision.com/display/CS5v2/About+Security
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Warranties
1-Year Limited Hardware Warranty
Haivision warrants its hardware products against defects in materials and workmanship under normal use 
for a period of ONE (1) YEAR from the date of equipment shipment ("Warranty Period"). If a hardware 
defect arises and a valid claim is received within the Warranty Period, at its option and to the extent 
permitted by law, Havision will either (1) repair the hardware defect at no charge, or (2) exchange the 
product with a product that is new or equivalent to new in performance and reliability and is at least 
functionally equivalent to the original product. A replacement product or part assumes the remaining 
warranty of the original product or ninety (90) days from the date of replacement or repair, whichever is 
longer. When a product or part is exchanged, any replacement item becomes your property and the 
replaced item becomes Haivision's property.

EXCLUSIONS AND LIMITATIONS
This Limited Warranty applies only to hardware products manufactured by or for Haivision that can be 
identified by the "Haivision" trademark, trade name, or logo affixed to them. The Limited Warranty does 
not apply to any non-Haivision hardware products or any software, even if packaged or sold with 
Haivision hardware. Manufacturers, suppliers, or publishers, other than Haivision, may provide their own 
warranties to the end user purchaser, but Haivision, in so far as permitted by law, provides their products 
"as is".

Haivision does not warrant that the operation of the product will be uninterrupted or error-free. Haivision 
does not guarantee that any error or other non-conformance can or will be corrected or that the product 
will operate in all environments and with all systems and equipment. Haivision is not responsible for 
damage arising from failure to follow instructions relating to the product's use.

This warranty does not apply:

(a) to cosmetic damage, including but not limited to scratches, dents and broken plastic on ports;

(b) to damage caused by accident, abuse, misuse, flood, fire, earthquake or other external causes;

(c) to damage caused by operating the product outside the permitted or intended uses described by 
Haivision;

(d) to a product or part that has been modified to alter functionality or capability without the written 
permission of Haivision; or

(e) if any Haivision serial number has been removed or defaced.

TO THE EXTENT PERMITTED BY LAW, THIS WARRANTY AND REMEDIES PROVIDED ABOVE ARE 
EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, REMEDIES AND CONDITIONS, WHETHER 
ORAL OR WRITTEN, STATUTORY, EXPRESS OR IMPLIED. AS PERMITTED BY APPLICABLE LAW, 
HAIVISION SPECIFICALLY DISCLAIMS ANY AND ALL STATUTORY OR IMPLIED WARRANTIES, 
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INCLUDING, WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND WARRANTIES AGAINST HIDDEN OR LATENT DEFECTS. IF HAIVISION 
CANNOT LAWFULLY DISCLAIM STATUTORY OR IMPLIED WARRANTIES THEN TO THE EXTENT 
PERMITTED BY LAW, ALL SUCH WARRANTIES SHALL BE LIMITED IN DURATION TO THE DURATION 
OF THIS EXPRESS WARRANTY AND TO REPAIR OR REPLACEMENT SERVICE AS DETERMINED 
BY HAIVISION IN ITS SOLE DISCRETION. No Haivision reseller, agent, or employee is authorized to make 
any modification, extension, or addition to this warranty. If any term is held to be illegal or unenforceable, 
the legality or enforceability of the remaining terms shall not be affected or impaired.

EXCEPT AS PROVIDED IN THIS WARRANTY AND TO THE EXTENT PERMITTED BY LAW, HAIVISION IS 
NOT RESPONSIBLE FOR DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING 
FROM ANY BREACH OF WARRANTY OR CONDITION, OR UNDER ANY OTHER LEGAL THEORY, 
INCLUDING BUT NOT LIMITED TO LOSS OF USE; LOSS OF REVENUE; LOSS OF ACTUAL OR 
ANTICIPATED PROFITS (INCLUDING LOSS OF PROFITS ON CONTRACTS); LOSS OF THE USE OF 
MONEY; LOSS OF ANTICIPATED SAVINGS; LOSS OF BUSINESS; LOSS OF OPPORTUNITY; LOSS OF 
GOODWILL; LOSS OF REPUTATION; LOSS OF, DAMAGE TO OR CORRUPTION OF DATA; OR ANY 
INDIRECT OR CONSEQUENTIAL LOSS OR DAMAGE HOWSOEVER CAUSED INCLUDING THE 
REPLACEMENT OF EQUIPMENT AND PROPERTY, ANY COSTS OF RECOVERING, PROGRAMMING, OR 
REPRODUCING ANY PROGRAM OR DATA STORED OR USED WITH HAIVISION PRODUCTS AND ANY 
FAILURE TO MAINTAIN THE CONFIDENTIALITY OF DATA STORED ON THE PRODUCT. THE 
FOREGOING LIMITATION SHALL NOT APPLY TO DEATH OR PERSONAL INJURY CLAIMS, OR ANY 
STATUTORY LIABILITY FOR INTENTIONAL AND GROSS NEGLIGENT ACTS AND/OR OMISSIONS.

OBTAINING WARRANTY SERVICE
Before requesting warranty service, please refer to the documentation accompanying this hardware 
product and the Haivision Support Portal https://support.haivision.com. If the product is still not 
functioning properly after making use of these resources, please contact Haivision or Authorized Reseller 
using the information provided in the documentation. When calling, Haivision or Authorized Reseller will 
help determine whether your product requires service and, if it does, will inform you how Haivision will 
provide it. You must assist in diagnosing issues with your product and follow Haivision's warranty 
processes.

Haivision may provide warranty service by providing a return material authorization ("RMA") to allow you 
to return the product in accordance with instructions provided by Haivision or Authorized Reseller. You 
are fully responsible for delivering the product to Haivision as instructed, and Haivision is responsible for 
returning the product if it is found to be defective. Your product or a replacement product will be 
returned to you configured as your product was when originally purchased, subject to applicable 
updates. Returned products which are found by Haivision to be not defective, out-of-warranty or 
otherwise ineligible for warranty service will be shipped back to you at your expense. All replaced 
products and parts, whether under warranty or not, become the property of Haivision. Haivision may 
require a completed pre-authorized form as security for the retail price of the replacement product. If you 
fail to return the replaced product as instructed, Haivision will invoice for the pre-authorized amount.

APPLICABLE LAW
This Limited Warranty is governed by and construed under the laws of the Province of Quebec, Canada.

This Limited Hardware Warranty may be subject to Haivision's change at any time without prior notice.

https://support.haivision.com
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EULA - End User License Agreement

READ BEFORE USING
THE LICENSED SOFTWARE IS PROTECTED BY COPYRIGHT LAWS AND TREATIES. READ THE TERMS 
OF THE FOLLOWING END USER (SOFTWARE) LICENSE AGREEMENT ("AGREEMENT") CAREFULLY 
BEFORE ACCESSING THE LICENSED SOFTWARE. BY SCANNING THE QR CODE TO REVIEW THIS 
AGREEMENT AND/OR ACCESSING THE LICENSED SOFTWARE, YOU CONFIRM YOUR ACCEPTANCE 
OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THESE TERMS, HAIVISION IS UNWILLING TO 
LICENSE THE LICENSED SOFTWARE TO YOU AND YOU ARE NOT AUTHORIZED TO ACCESS THE 
LICENSED SOFTWARE.

Click the following link to view the Software End-User License Agreement: Haivision EULA.pdf

If you have questions, please contact legal@haivision.com

SLA - Service Level Agreement

1. Introduction
This Service Level and Support supplement forms a part of and is incorporated into the Service 
Agreement (the “Agreement”) between You and Haivision Network Video Inc. (“Haivision”).  Capitalized 
terms used but not otherwise defined in this supplement shall have the meaning ascribed to them in the 
Agreement. Haivision may, upon prior written notice to You, amend this supplement to incorporate 
improvements to the service levels and support commitments at no additional cost to You. This 
supplement applies only to those products and services set forth below.

2. Definitions
"Audience Member" means an individual or entity that accesses Your Published Media Objects 
through a public URL.
"Access Service" means the service provided by Haivision VCMS that verifies an Audience 
Member’s credentials.
"Digital Media File" means a computer file containing text, audio, video, or other content.
"Outage" is a 12-minute period of consecutive failed attempts by all six agents to PING the domain 
on the Haivision Streaming Media network.
"Published Media Object" means a Digital Media File with a public URL.
"Transaction" means the creation of a right for an Audience Member to access a Media Object and 
the completion of an order logged in the order history service.

3. Service Levels for the Video Content Management System
The service levels in this Section 3 apply only to the hosted version of Haivision VCMS and the Haivision 
VCMS development kit (collectively, the “Standard Hosted Components” of Haivision Video Cloud 
Services). Subject to the exceptions noted in Section 4 below, the aforementioned components of 
Haivision Video Cloud Services will be available for use over the course of each calendar month as 
follows:

https://doc.haivision.com/download/attachments/6428332/Haivision%20EULA.pdf?api=v2&modificationDate=1695739481517&version=1
mailto:legal@haivision.com
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a.
b.
c.

d.
e.
f.

g.

•

•
•

•

Type of Access Definition Availability 
Level

Write Functions Access to all functions through the administrative user interface.
Ability to add or modify objects and metadata through the application 
programming interface (“API”)
Ability of ingest service to check for new or updated files or feeds

99.999%

Read-Only 
Functions

Ability to retrieve data through the API
Ability for Audience Members to authenticate through the Access Service
Ability for Audience Members to play Published Media Objects
Ability for Audience Members to play Haivision VCMS-authenticated or 
entitled Published Media Objects
Ability to complete Transactions

99.999%

4. Exceptions to Availability for the VCMS
The Standard Hosted Components may not be available for use under the following circumstances, and in 
such case such periods of unavailability shall not be counted against Haivision Video Cloud for purposes 
of calculating availability:

Normal Maintenance, Urgent Maintenance and Upgrades as defined in the table below;
Breach of the Agreement by You as defined in the Agreement;
The failure, malfunction, or modification of equipment, applications, or systems not controlled by 
Haivision Video Cloud;
Any third party, public network, or systems unavailability;
Acts of Force Majeure as defined in the Agreement;
Modification of software made available to You as part of Haivision Video Cloud Services by You or 
a third party acting on Your behalf; and
Any third party product or service not incorporated into Haivision Video Cloud Services or any 
third party plug-in.

Haivision Video Cloud shall make commercially reasonable efforts to notify, or work with, applicable third 
parties to repair or restore Haivision VCMS functionality affected by such exceptions.

Type of 
Mainten
ance

Purpose Write 
Functi

ons 
Availa

ble

Read 
Functi

ons 
Availa

ble

Maxim
um 

Time 
Per 

Month

Continu
ous 

Time in 
Mode 
(Max)

Windo
w 

(Centr
al 

Time)

Min 
Notice

Normal Preventive maintenance on the software/
hardware components of Haivision VCMS
Addition of new features/functions
Repair errors that are not immediately 
affecting Your use of Haivision VCMS

No Yes 10 
Hours

6 Hours 10:00p
m - 

5:00a
m

48 
Hours

Urgent Repair errors that are immediately affecting 
Your use of Haivision VCMS

No Yes 30 
Minute

s

15 
Minutes

Any 
Time

3 
Hours
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Type of 
Mainten
ance

Purpose Write 
Functi

ons 
Availa

ble

Read 
Functi

ons 
Availa

ble

Maxim
um 

Time 
Per 

Month

Continu
ous 

Time in 
Mode 
(Max)

Windo
w 

(Centr
al 

Time)

Min 
Notice

Upgrade
s

Perform upgrades on software or hardware 
elements necessary to the long term health 
or performance of Haivision VCMS, but 
which, due to their nature, require that 
certain components of Haivision VCMS to 
be shut down such that no access is 
possible

No No 1 Hour 1 Hour 12:00a
m  - 

4:00a
m

M-F

5 Days

5. Credits for Downtime for the VCMS
Haivision Video Cloud will grant a credit allowance to You if You experience Downtime in any calendar 
month and you notify Haivision Video Cloud thereof within ten (10) business days after the end of such 
calendar month. In the case of any discrepancy between the Downtime as experienced by You and the 
Downtime as measured by Haivision Video Cloud, the Downtime as measured by Haivision Video Cloud 
shall be used to calculate any credit allowance set forth in this section. Such credit allowance shall be 
equal to the pro-rated charges of one-half day of Fees for each hour of Downtime or fraction thereof. The 
term “Downtime” shall mean the number of minutes that Standard Hosted Components are unavailable to 
You during a given calendar month below the availability levels thresholds in Section 3, but shall not 
include any unavailability resulting from any of the exceptions noted in Section 4. Within thirty (30) days 
after the end of any calendar month in which Downtime occurred below the availability levels thresholds 
in Section 3, Haivision Video Cloud shall provide You with a written report detailing all instances of 
Downtime during the previous month. Any credit allowances accrued by You may be offset against any 
and all Fees owed to Haivision Video Cloud pursuant to the Agreement, provided that a maximum of one 
month of credit may be accrued per month.

6. Support Services for the VCMS
Support for Haivision Video Cloud Services as well as the Application Software (defined as the VCMS 
application software components that Haivision licenses for use in conjunction with the Video Cloud 
Services) can be reached at hvc-techsupport@haivision.com and shall be available for all Your support 
requests.  Haivision Video Cloud will provide 24x7 monitoring of the Standard Hosted Components.

Cases will be opened upon receipt of request or identification of issue, and incidents will be routed and 
addressed according to the following:

Severity Level Error State Description Status 
Response 
Within

Incident 
Resolutio
n within

1 – Critical 
Priority

Renders Haivision VCMS inoperative or causes Haivision VCMS to fail 
catastrophically.

15 
minutes

4 hours

2 – High 
Priority

Affects the operation of Haivision VCMS and materially degrades Your 
use of Haivision VCMS.

30 
minutes

6 hours

3 – Medium 
Priority

Affects the operation of Haivision VCMS, but does not materially degrade 
Your use of Haivision VCMS.

2 hours 12 hours

mailto:hvc-techsupport@haivision.com
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a.

b.

c.
d.

Severity Level Error State Description Status 
Response 
Within

Incident 
Resolutio
n within

4 – Low Priority Causes only a minor impact on the operation of Haivision VCMS. 1 business 
day

3 
business 

days

7. Service Levels for Haivision Streaming Media Service
Haivision agrees to provide a level of service demonstrating 99.9% Uptime. The Haivision Streaming 
Media Service will have no network Outages.

The following methodology will be employed to measure Streaming Media Service availability:

Agents and Polling Frequency

From six (6) geographically and network-diverse locations in major metropolitan areas, Haivision’s 
Streaming Media will simultaneously poll the domain identified on the Haivision Streaming Media 
network.
The polling mechanism will perform a PING operation, sending a packet of data and waiting for a 
reply. Success of the PING operation is defined as a reply being received.
Polling will occur at approximately 6-minute intervals.
Based on the PING operation described in (b) above, the response will be assessed for the purpose 
of measuring Outages.

If an Outage is identified by this method, the customer will receive (as its sole remedy) a credit equivalent 
to the fees for the day in which the failure occurred.

Haivision reserves the right to limit Your use of the Haivision Streaming Media network in excess of Your 
committed usage in the event that Force Majeure events, defined in the Agreement, such as war, natural 
disaster or terrorist attack, result in extraordinary levels of traffic on the Haivision Streaming Media 
network.

8. Credits for Outages of Haivision Streaming Media Service
If the Haivision Streaming Media network fails to meet the above service level, You will receive (as your 
sole remedy) a credit equal to Your or such domain’s committed monthly service fee for the day in which 
the failure occurs, not to exceed 30 days of fees.

9. No Secondary End User Support
UNDER NO CIRCUMSTANCES MAY YOU PROVIDE CONTACT INFORMATION FOR HAIVISION SERVICES 
TO CUSTOMERS OR AUDIENCE MEMBERS OR OTHER THIRD PARTIES WITHOUT HAIVISION’S EXPRESS 
PRIOR WRITTEN CONSENT.
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Getting Help
General Support North America (Toll-Free)

1 (877) 224-5445

International
1 (514) 334-5445

and choose from the following: 
Sales - 1, Cloud Services - 3, Support - 4

Managed Services U.S. and International
1 (512) 220-3463

Fax 1 (514) 334-0088

Support Portal https://support.haivision.com

Product Information info@haivision.com

https://support.haivision.com
mailto:info@haivision.com


info@haivision.com
www.haivision.com

North America: 1.877.224.5445
International: +1.514.334.5445
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